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Abstract

This article introduces the gsemthesis class for IXTEX. The gsemthesis class
is a PhD thesis template for the Geneva School of Economics and Management
(GSEM), University of Geneva, Switzerland. The class provides utilities to easily
set up the cover page, the front matter pages, the pages headers, etc. with respect
to the official guidelines of the GSEM Faculty for writing PhD dissertations. This
class is released under the LaTeX Project Public License version 1.3c.

*This document corresponds to gsemthesis v0.9.4, dated 2015/02/09.
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1 Introduction

PhD thesis published within the Geneva School of Economics and Management have to
follows some guidelines, especially for the cover page. The gsemthesis class is a BTEX
template providing utilities to easily set up these guidelines in your thesis. In addition the
class loads several usefull packages generally used when writing a thesis. We recommend
the user to have a look to the class definition in Section 4.1 to be aware of the list of
packages that the class already includes. The Section 2 details how to start with the
gsemthesis class and how to configure your thesis. The Section 3 provides a minimal
working example you can copy/paste for starting your dissertation. The user interested
in customizing the class can read the Section 4 which details the full implementation of
the class with usefull comments.

This class was successfully tested with TeX Live 2013/Debian, TeX Live 2014/Cen-
tOS;Windows7 and MiKTeX-2.9.5105/Windows7.

This class has been written by Emmanuel ROUSSEAUX with contributions from
William AEBERHARD and Tuan NGUYEN.

The development version is hosted on GitHub!. If you are interested in contributing
to this class or if you want to beta test latest versions, please visit the repository.

2 Usage

This Section introduces the use of the gsemthesis class. All macros and environments
the class provides are described. We assume the user is already familiar with EXTREX.

2.1 Requirements

The class requires a recent version of either TeX Live (> 2014 recommended, > 2013
minimal) or MiKTeX (> 2.9.5x minimal). As the class preload some common packages
(see Section 4 for the detailed list), we suggest to use install your ITEX distribution in
full mode to make things working out-of-the-box.

The class uses biblatex/biber for managing the bibliography. Please refer to the Section
2.8 for configuring your editor to use it.

2.2 Getting started

To use the class start your document with the command \documentclass{gsemthesis}.
A minimal document is:

\documentclass{gsemthesis}
\begin{document}
\printcoverpage

\newpage

Here is it, I started my PhD!
\end{document}

The Section 3 provides a minimal working example you can copy/paste for starting your
dissertation. Commands available for configuring your thesis are explained in the follow-
ing sections.

lhttps://github.com/emmanuelrousseaux/gsemthesis
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\printcoverpage

\title

\date
\authorFirstname
\authorLastname
\thesisField

\thesisCommitteeA-F

\thesisNumber

\printfrontmatter

\acknowledgements
\abstractEN
\abstractFR
\dedication

2.3 Configuring your editor to store files in UTF-8

The class assumes that all your .tex and .bib files are encoded in UTF-8. The UTF-8
encoding is a dominant character encoding available on all recent systems and used by
default by a lot of editors. As a consequence, it limits encoding problems when sharing files
from different systems (Windows, MacOS, Unix/Linux, web sites, etc.). If some of your
source files are stored with a different encoding, you may experience rendering problems
with accentued/foreign characters. These characters can occur, for instance, in author
names of the bibliography. For making sure you won’t experience rendering problems,
consider (1) storing your files in UTF-8 and (2) set UTF-8 as the default encoding of your
editor. Any recent text editor is able to convert files to UTF-8. TeXstudio and TeXmaker
seem to used UTF-8 by default. Rstudio seems to use the system default encoding. To
change this setting go to File > Save with encoding. On NotePad++ go to Encoding >
Convert to UTF-8.

2.4 Writing the dissertation in French

The GSEM accepts English and French for PhD thesis dissertations. Default language is
English. If you write your dissertation in French, you have to you the fr class option as
follows:

\documentclass[fr]{gsemthesis}

2.5 Configuring and printing the cover page

The class provides the GSEM PhD thesis cover page ready to be printed. You can ask to
print it by calling \printcoverpage just after the \begin{document}. Before printing the
cover page you first need to configure it with your thesis details: title, author, supervisors,
committee, etc.

The class uses the classical \title{text} and \date{tezrt} commands of the book class
to set the title and the date. Instead of using the \author{tert} command we provide
the two commands \authorFirstname{texrt} and \authorLastname{tert} to separately
handle the firstname and the lastname. You specify the PhD you are enrolled in with the
\thesisField{text}, among others: Economics, Management, Statistics, Information
Systems. Please contact the scientific committee of your PhD to obtain the applicable
title. You can specify information about members of your thesis committee with the
six \thesisCommitteeA-F{title}{firstname}{lastname}{role} commands. With the role
field you specify the role played by this member in the committee and his/her affiliation.
Generally you specify the role “Chair” in \thesisCommitteeA, the role “adviser” for
your adviser/co-advisers, and leave the field empty for the other members. When your
manuscript has been accepted by your jury, the Faculty attributes a unique thesis number
which has to be printed on the cover page. The \thesisNumber{text} allows to supply
it.

2.6 Configuring and printing the front matter pages

After the cover page the thesis has to provide in a the following order (1) the ac-
knowledgements, (2,3) an abstract in both English and French (the order depend-
ing on the main language of your dissertation: if your dissertation is written in
English you will start with the English abstract; if your dissertation is written in
Frenchyou will start with the French abstract), (4) the table of contents, and (5)
an optional dedication. These elements are usually called the front matter. These
pages will be printed by calling the \printfrontmatter command. The best place
for this command is just after the \printcoverpage command. To fill these pages use
the commands \acknowledgements{text}, \abstractEN{texzt}, \abstractFR{text}, and



\startintroduction
\startconclusion

\dedication{text}. We suggest you use these commands in the preambule of the docu-
ment, just after the commands used to set the cover page.

2.7 Introduction and conclusion

Generally we don’t want to number the introduction and the conclusion, but we want
they appear in the table of contents. This leads to a specific handling of the creation
of these chapter, especially to have correct page headers. Therefore, instead of using
\chapter{introduction} (respectively \chapter{conclusion}) to start a such chapter
we provide the function \startintroduction (respectively \startconclusion) to easily
start the chapter with a correct handling of the table of contents and page headers.

2.8 Bibliography

To produce the bibliography, the gsemthesis class uses the package biblatex with biber
in backend instead of the package bibtex. The package biblatex is installed by default
with any recent version of TeX Live? (full installation) and MiKTeX, but you must first
configure your TeX Editor to use it.

2.8.1 Configure TeXstudio to run biber

In the TeXstudio preferences (click on Options — Configure TeXstudio), choose the
‘Build’ tab and modify the ‘Default Bibliography’ to ‘Biber’.

Run ‘Build & View’ from the ‘Tools’ menu (or press the two green arrows icon), which
will create a PDF but with the bibliography not completed.

Run ‘Bibliography’ from the ‘Tools’ menu.
Run ‘Build & View’ again to create a PDF with the bibliography.

2.8.2 Configure Texmaker to run biber

In the Texmaker preferences (click on Options — Configure Texmaker), choose the ‘Com-
mands’ tab and replace bibtex % by biber % in the field Bib(1la)tex. On Windows, you
may also browse to the biber.exe using the folder icon on the side.

Choose the ‘Quick Build’ tab and select the second option PdfLaTeX + Bib(la)tex +
PdfLaTex (x2) + View Pdf

Now your ‘Quick Build’ button will create a PDF with the bibliography.

2.8.3 Configure Rstudio/knitr to run biber

In Rstudio/knitr you have to include the following chunk in your .Rnw document:

<<tex-setup, include=FALSE, cache=FALSE, echo=FALSE>>=
Sys.setenv(
TEXINPUTS=getwd (),
BIBINPUTS=getwd (),
BSTINPUTS=getwd ()
)
¢

20n Ubuntu/Debian, you may have to install it manually: sudo apt-get install texlive-bibtex-extra
biber



itemizex*

2.8.4 Basic commands

To add a bibliography into your document, you have to define your bib file in the preamble
of your tex file: \addbibresource{literature-review-topicl.bib} Then, at the end
of your document, the command \printbibliography will create the biblography.

2.8.5 Using you own bibliography management configuration

If you prefer not to use the bibliography management configuration we implemented in
this class, you can disabled it and writing you own. Disabling the gsemthesis bibliography
management configuration is easily done with the custombib class option:

\documentclass [custombib] {gsemthesis}

When using this option you will have to provide the package you want to use for managing
your bibliography (natbib, chapterbib, etc.). As the option disables all settings you will
also need to load the package biblatex if you want to use it.

2.9 Draft mode

When sharing draft versions of your dissertation you may prefer to hide some items of the
cover page (thesis committee, thesis number, etc.) and some Sections (acknowledgments,
the dedications. etc.) that probably have not been defined yet. For this purpose you can
use the draft option:

\documentclass[draft]{gsemthesis}

Note: this draft mode extends the classical A TEXdraft mode and then all packages sup-
porting a draft mode will also switch to the draft mode®. For convenience purposes we
forced packages graphicx and hyperref to be in final mode even when draft mode is on.

2.10 Miscellaneous

The class also provides some optional functions that can turn out to be usefull when
writing your thesis. The default itemize environment set important spaces between
each items, the previous paragraph and the next paragraph. The itemize* environment
reduces these spaces to allow a more compact (and nicer) presentation of a list item.
Forthcoming. To add: section in redaction, todonotes

3Common packages supporting a draft mode are: changes (final disables markup of changes, and list of
changes), graphics (draw frames instead of including images), graphicx (draw frames instead of including
images), hyperref (disable all linking features), listings (don’t include external files), listofsymbols
(final suppresses printing of macro names and unused symbols), mfpic (assume every latex run to be the
first one), microtype (disable all features), pdfcomment (final suppresses the comments), pdfpages (don’t
include external file but print a frame box), pgf (similar to graphics/x: all images will be replaced by
empty rectangles), showkeys (draft shows the labels, the default option), thumbs (thumbs’ width=2pt,
thumbs’ text=Dblack, thumbs’ color=grey), varioref (turn warnings in error messages). Source: http:
//tex.stackexchange.com/questions/49277/what-does-the-draft-mode-change/49278
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3 Minimal working example
\documentclass{gsemthesis}

\title{An innovative approach to deal with a very important issue}
\date{\today}

\authorFirstname{Firstname}

\authorLastname{Lastname}
\thesisField{Econometrics}

\thesisCommitteeA{Prof.}{Mike}{Moore}{Adviser, University of Geneva}
\thesisCommitteeB{Prof.}{Mike}{Moore}{Chair, University of Honolulu}
\thesisCommitteeC{Prof.}{Mike}{Moore}{University of Omsk}
\thesisCommitteeD{Dr.}{Mike}{Moore}{Eidgendssische Technische Hochschule Ziirich}
\thesisNumber{480}

\acknowledgements{Your acknowledgements}

\abstractEN{English version of the abstract}

\abstractFR{French version of the abstract}

\dedication{To my family.}

\addbibresource{literature-review-topicl.bib}
\addbibresource{literature-review-topic2.bib}

\begin{document}
\printcoverpage
\printfrontmatter

% INTRODUCTION
\startintroduction

Write your introduction here.

% CHAPTER
\chapter{A first chapter}
\label{ch:chapterone}

My chapter 1.

% CONCLUSION
\startconclusion

The conclusion.

% BACKMATTER

\listoftables
\listoffigures

% Bibliography (at the end)
\newpage

\printbibliography

\end{document}



4 Implementation

In this Section the full code of the gsemthesis is discussed. The reader interested in
customizing the class will find useful comments to understand the design of the class.

4.1 Document properties

The class is derived from the standard book class as follows:
1 \LoadClass [a4paper, 12pt , twoside] {book}
We set the document encoding to UTF-8
2 \usepackage [ut£8] {inputenc}
We use the 1lmodern vectorial fonts to render the document.
3 \usepackage{lmodern}
We use the etoolbox package for defining class options (fr, draft)
4 \usepackage{etoolbox}
We add the option fr

5 \newtoggle{fr}
6 \DeclareOption{fr}{\toggletrue{fr}}

We add the option draft

7 \newtoggle{draft}
8 \DeclareOption{draft}{\toggletrue{draft}}

We add the option custombib

9 \newtoggle{custombibl}
10 \DeclareOption{custombib}{\toggletrue{custombib}}

The recommended page format is A4. The B5 page format is given in option.

11 \DeclareOption{b5paper}+{
12 \PassOptionsToClass{\CurrentOption}{book}
13 }

14 \ProcessOptions

We use the geometry package to set margin properties

15 \RequirePackage [top=2.5cm, bottom=2.5cm, left=2.5cm, right=2.5cm]{geometry}
We use the package to handle some specific text spacing (title)

16 \usepackage{setspace}

4.2 Colors

We define some nice colors that will be later used for links (url, email, citations, etc.).
The gsemblue color is the official color (to date 2014.02.20) of the GSEM Faculty.

17 \usepackage{xcolor}

18 \definecolor{erblue}{HTML}{126199}

19 \definecolor{erorange}{HTML}{FF7F00}

20 \definecolor{gsemblue}{HTML}{465F7F}

4.3 Graphics

We add some practical packages to handle several image files (.png, .pdf), handle place-
ment of graphics, and handle subfigures

21 \usepackage [final] {graphicx}

22 \usepackage{float}

23 \usepackage{subfigure}



4.4 Link management

We use the hyperref package to manage internal links and set colors for each link type.

24 \RequirePackage{hyperref}
25 % \hypersetup{/

26 % colorlinks=true,%

27 % linkcolor=black,%

28 % filecolor=gsemblue,’
29 %, citecolor=gsemblue,
30 % urlcolor=gsemblue},
31% Yh

32 \hypersetup{

33 colorlinks=true,

34 linkcolor=black,

35 filecolor=erblue,

36 citecolor=erblue,

37 urlcolor=erblue,

38 final

39 }

We use the url package for a complete support of external links and define a nice font
style.

40 \RequirePackage{url}
41 \urlstyle{sf}

4.5 Maths

We add standard packages from the American Mathematical Society to handle mathe-
matical symbols, environment (equations, etc.) and the Computer Modern font use by
default to render math.

42 \usepackage{amssymb,amsmath,amsfonts}

4.6 Page headers management

We use the fancyhdr package for a fine tuning of headers and footers of the different
page type (cover page, chapters, unumbered chapters, etc.).

43 \usepackage{fancyhdr}

The capital letters given in option of \fancyhead or \fancyfoot commands respectively
stands for:

E: Even page

O: Odd page

L: Left field

C: Center field

R: Right field

H: Header

F: Footer

We set the fancy page style (default page style) as follows:

44 \pagestyle{fancy}

45 \fancyhf{}

46 \fancyhead[LE]{\thepage}

47 \fancyhead [RE] {\nouppercase{\leftmarkl}}
48 \fancyhead[LO] {\nouppercase{\rightmark}}
49 \fancyhead[RO] {\thepage}

50 \fancyfoot [LE,RO]{}



We reset the plain style

51 \fancypagestyle{plain}{

52 \fancyhf{}

53 \renewcommand{\headrulewidth}{Opt}
54 \fancyfoot[LE,RO]{}

55

We define a style for the cover page (actually not used)

56 \fancypagestyle{cover}{

57 \fancyhf{}

58 \renewcommand{\headrulewidth}{0.5pt}
59  \renewcommand{\footrulewidth}{0.5pt}
60

We define a style for unumbered chapters (starred chapters)

61 \fancypagestyle{unnumberedchapter}{

62 \fancyhf{}

63 \renewcommand{\headrulewidth}{Opt}

64 \renewcommand{\footrulewidth}{Opt}

65 \fancyhead[LE]{\thepage}

66 \fancyhead[RE]{}

67 \fancyhead[LO]{}

68 \fancyhead[RO]{\thepage}

69 \fancyfoot[LE,R0]{}

70 }

When a new chapter starts on a odd number, we add a blank page to force it to start to
a even number. We define an empty style for this blank page
71 \fancypagestyle{empty}{

72 \fancyhf{}

73 \renewcommand{\headrulewidth}{Opt}

74 \fancyfoot[LE,R0]{}

75 }

Then we apply the empty style to odd page before a new chapter

76 \def\cleardoublepage{\clearpage\if@twoside \ifodd\c@page\else
77 \hbox{}

78 \thispagestyle{empty}
79 \newpage
80 \if@twocolumn\hbox{}\newpage\fi\fi\fi}

81 \clearpage{\pagestyle{empty}\cleardoublepage}
We define the default language of the document.

82 \iftoggle{fr}{

83 \usepackage[francais]{babel}
84 \usepackage[T1]{fontenc}

85 H{

86 \usepackage[english]{babel}
87}

This package provides the commands \og and \fg for correctly handling French quotes.
88 \usepackage{csquotes}
We define the date format for the cover page (non-draft mode).

89 \usepackage{datetime}
90 \newdateformat{monthyeardate}{\monthname [\THEMONTH] \THEYEAR}

4.7 Bibliography management

We use biblatex/biber to process the bibliography with the following settings: (1) citations
with more than two authors will always be writen as “First author et al.”, (2) this “et

10



al.” rule is applied even if it leads to ambiguities between long list of authors with the
same first author.

91 \iftoggle{custombib}{}{

92 \usepackage [backend=biber,natbib=true,style=authoryear-comp,sorting=nymdt,’
93 maxbibnames=99,mincitenames=1,maxcitenames=2,uniquelist=false]{biblatex}

94 }

We use the style authoryear to print authors and the year when citing a document in the
text. We define a customized sorting style to sort the list of references (printed at the
end of the document) according to this (ordered) attributes: name, year, month, day, and
title. We define the following sorting scheme:

95 \iftoggle{custombib}{}{
96 \DeclareSortingScheme{nymdt}{

97 \sortq{

98 \field{presort}
99 }

100 \sort [final]{

101 \field{sortkey}
102 }

103 \sort{

104 \name{sortname}
105 \name{author}

106 \name{editor}

107 \name{translator}
108 \field{sorttitle}
109 \field{title}

110 }

111 \sort{

112 \field{sortyear}
113 \field{year}

114 }

115 \sort{

116 \field[padside=left,padwidth=2,padchar=0]{month}
117 \literal{00}

118 }

119 \sort{

120 \field[padside=left,padwidth=2,padchar=0]{day}
121 \literal{00}

122 }

123 \sort{

124 \field{sorttitle}
125 }

126 \sort{

127 \field[padside=left,padwidth=4,padchar=0]{volume}
128 \1literal{0000}
129 }

130 }

131 }

4.8 Cover page
4.8.1 System-level functions

The following commands define labels for the different parts of the cover page

132 \def\theFaculty{Geneva School of Economics and Management}
133

134 \def\thesisLocationLabelq{

135 7 \\[0.4em]%

136 \iftoggle{fr}{
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\authorFirstname

\authorLastname

\thesisField

\thesisCommitteeA

137 Une thése soumise a 1la\\[0.2em]
138 \theFaculty\\[0.2em]

139 Université de Genéve, Suisse,\\[0.2em]

140 pour 1’obtention dul\\[0.2em]

141 M

142 A thesis submitted to the\\[0.2em]

143 \theFaculty, \\[0.2em]

144 University of Geneva, Switzerland,\\[0.2em]

145 in fulfillment of the requirements for the degree of\\[0.2em]
146}

147 }

148

149 \iftoggle{fr}{

150  \def\thesisByLabel{par}

151 H

152 \def\thesisByLabel{by}

153 }

154 \iftoggle{fr}{

155 \def\thesisFieldLabel{Doctorat en}
156 H

157 \def\thesisFieldLabel{PhD in}

158 }

159 \iftoggle{fr}{

160  \def\thesisCommitteeLabel{Membres du jury:}
161 H{

162 \def\thesisCommitteeLabel{Members of the thesis committee:}
163 }

164 \iftoggle{fr}{

165 \def\thesisNumberLabel{Thé&se no.}
166 H

167 \def\thesisNumberLabel{Thesis No.}
168 }

169

4.8.2 TUser-level functions

Set up of the cover page and assimilated functions.

Set up the \theauthorFirstname variable.

170 \def\theauthorFirstname{}
171 \newcommand{\authorFirstname} [1]{\def\theauthorFirstname{#1}}

Set up the \theauthorLastname variable.

172 \def\theauthorLastname{}
173 \newcommand{\authorLastname} [1]{\def\theauthorLastname{\textsc{#1}}}

Set up the \thethesisField variable.

174 \def\thethesisField{}
175 \newcommand{\thesisField} [1]{\def\thethesisField{#1}}

Set up the \thethesisCommitteeA variable.

176 \def\thethesisCommitteeA{}

177 \newcommand{\thesisCommitteeA} [4]{%

178 \ifx&#3&%,

179  \def\thethesisCommitteeA{}’

180 \else

181 \def\thethesisCommitteeA{#1 #2 \textsc{#3}, #4}J
182 \fi

183 }

12



\thesisCommitteeB Set up the \thethesisCommitteeB variable.

184 \def\thethesisCommitteeB{}

185 \newcommand{\thesisCommitteeB} [4]{%

186 \ifx&#3&%

187 \def\thethesisCommitteeB{}/

188 \else

189 \def\thethesisCommitteeB{#1 " #2 \textsc{#3}, #4}J
190 \fi

191 }

\thesisCommitteeC Set up the \thethesisCommitteeC variable.

192 \def\thethesisCommitteeC{}

193 \newcommand{\thesisCommitteeC} [4]{%

194 \ifx&#3&%

195 \def\thethesisCommitteeC{}/

196 \else

197 \def\thethesisCommitteeC{#1 " #2 \textsc{#3}, #4}J
198 \fi

199 }

\thesisCommitteeD Set up the \thethesisCommitteeD variable.

200 \def\thethesisCommitteeD{}

201 \newcommand{\thesisCommitteeD} [4]{%

202 \ifx&#3&,

203 \def\thethesisCommitteeD{1}%

204 \else

205 \def\thethesisCommitteeD{#1 " #2 \textsc{#3}, #4}J
206 \fi

207 }

\thesisCommitteeE Set up the \thethesisCommitteeE variable.

208 \def\thethesisCommitteeE{}

209 \newcommand{\thesisCommitteeE} [4]{%

210 \ifx&#3&%

211  \def\thethesisCommitteeE{}%

212 \else

213 \def\thethesisCommitteeE{#1 #2"\textsc{#3}, "#4}J
214 \fi

215 }

\thesisCommitteeF Set up the \thethesisCommitteeF variable.

216 \def\thethesisCommitteeF{}

217 \newcommand{\thesisCommitteeF} [4]{%

218 \ifx&#3&%

219 \def\thethesisCommitteeF{1}%

220 \else

221 \def\thethesisCommitteeF{#1 #2  \textsc{#3}, "#4}/
222 \fi

223 }

\thesisNumber Set up the \thethesisNumber variable.

224 \def\thethesisNumber{}
225 \newcommand{\thesisNumber}[1]{\def\thethesisNumber{#1}}

The cover page is created with the following code

\printcoverpage Print the cover page of the thesis.

226 \newcommand{\printcoverpage}{/

13



280
281
282
283
284
285

\thispagestyle{empty}

\begin{center}

\rule{\linewidth}{0.4pt}

\vspace*{1.2cm}

{\huge

{\scshape
\begin{spacing}{0.8}
\@title

\end{spacing}

}
}

\vspace*{1.2cm}
\thesisByLabel
\vspace*{0.4cm}
{\large \theauthorFirstname~\theauthorLastname}
\vspace*{0.8cm}

\thesisLocationLabel
\thesisFieldLabel{ " }\thethesisField

\vfill
\iftoggle{draft}{
\iftoggle{fr}{
\emph{Ebauche}
H
\emph{Draft}
}
}

\iftoggle{draft}{ " }{
\vspace*{0.8cm}

\thesisCommitteelLabel
}

\vspace*{0.2em}
\iftoggle{draft}{ " }{\thethesisCommitteeA}
\vspace*{0.2em}
\iftoggle{draft}{"}{\thethesisCommitteeB}
\vspace*{0.2em}
\iftoggle{draft}{~}{\thethesisCommitteeC}
\vspace*{0.2em}

\iftoggle{draft}{~}{\thethesisCommitteeD}

14



\acknowledgements

\abstractEN

\abstractFR

\dedication

\printfrontmatter

286  \vspacex{0.2em}

287

288 \iftoggle{draft}{ "}{\thethesisCommitteeE}
289

290 \vspace*{0.2em}

291

292 \iftoggle{draft}{"}{\thethesisCommitteeF}
293

294 \vspace*{1l.4cm}

295

206 \iftoggle{draft}{ }{\thesisNumberLabel{ }\thethesisNumber}
297

298 \vspacex{0.1lcm}

299

300 \iftoggle{draft}{\@date}{\monthyeardate\today}
301

302 \vspace*{0.1lcm}

303

304 \rule{\linewidth}{0.4pt}

305 \end{center}

306 ¥

4.9 Front matter

Set up the \theacknowledgements variable.

307 \def\theacknowledgements{}
308 \newcommand{\acknowledgements}[1]{\def\theacknowledgements{#1}}

Set up the \theabstractEN variable.

309 \def\theabstractEN{}
310 \newcommand{\abstractEN}[1]{\def\theabstractEN{#1}}

Set up the \theabstractFR variable.

311 \def\theabstractFR{}
312 \newcommand{\abstractFR}[1]{\def\theabstractFR{#1}}

Set up the \thededication variable.

313 \def\thededication{}
314 \newcommand{\dedication}[1]{\def\thededication{#1}}

The front matter pages are created with the following code

315 \newcommand{\printfrontmatter}{%

316

317 \iftoggle{draft}{"}{

318 \frontmatter

319

320 \iftoggle{fr}{

321 \chapter*{Remerciements}

322 \addcontentsline{toc}{chapter}{Remerciements}
323 H

324 \chapter*{Acknowledgements}

325 \addcontentsline{toc}{chapter}{Acknowledgements}
326 }

327 \label{ch:acknowledgements}

328 \thispagestyle{plain}

329 \theacknowledgements

330

331 \newpage
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\startintroduction

333 \iftoggle{fr}{

334 \chapter*{Résumé}

335 \addcontentsline{toc}{chapter}{Résumé}
336 \label{ch:abstractFR}

337 \thispagestyle{plain}

338 \theabstractFR

339

340 \newpage

341

342 \chapter*{Abstract}

343 \addcontentsline{toc}{chapter}{Abstract}
344 \label{ch:abstractEN}

345 \thispagestyle{plain}

346 \theabstractEN

347 H

348 \chapter*{Abstract}

349 \addcontentsline{toc}{chapter}{Abstract}
350 \label{ch:abstractEN}

351 \thispagestyle{plain}

352 \theabstractEN

353

354 \newpage

355

356 \chapter*{Résumé}

357 \addcontentsline{toc}{chapter}{Résumé}
358 \label{ch:abstractFR}

359 \thispagestyle{plain}

360 \theabstractFR

361 }

362}

363

364 \tableofcontents

366 \iftoggle{draft}{~}{

367 \cleardoublepage

368

369 \thispagestyle{plain}
370

371 \vspace*x{4cm}

372 {\em

373 \raggedleft\thededication\par
374 }

375

376 \newpage

377}

378

379 \mainmatter

380 }

4.10 Introduction and conclusion starter

The front matter pages are created with the following code

381 \newcommand{\startintroduction}{’

382 \chapter*{Introduction}

383 \addcontentsline{toc}{chapter}{Introduction}
384 \label{ch:introduction}

385 \markboth{}{Introduction}

386 }
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\startconclusion The front matter pages are created with the following code

387 \newcommand{\startconclusion}{J

388 \chapter*{Conclusion}

389 \addcontentsline{toc}{chapter}{Conclusion}
390 \label{ch:conclusion}

391 \markboth{}{Conclusion}

392 }

4.11 Miscellaneous

itemize* A narrowed version of the itemize environment. implementation here.

393 \newenvironment{itemizex}J

394 {\vspace{-2mm}\begin{itemizel}y,
395 \setlength{\itemsep}{Optl}/
396 \setlength{\parskip}{Opt}’

397 Yh
398 {\end{itemizel}\vspace{-2mm}J,
399}
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